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Time Allowed: 3 Hours

Maximum Marks: 60

Candidates are required to give their answers in their own words as far as practicable.

Multiple Choice Questions :

(12%1=12)
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1. Which of the following is an example of a strong password be awerdsd G\“\A“ﬂl%?

=R

1234
Neerul23
Cmps@123##
None of above

Ans : C. Cmps@123#

No mar s .

2. Ravi wants to create a new directory on Linux desktop . Which command should be used

by him.

a. Ls

b. Cd

e Pwd

d. Mkdir
Ans : tmkdir

3. What is Full form of LVM

a.
b.
C.
d.

Ans : a~-Logical Volume.

Logical Volume Management
Local Volume Management
Live Volume Management
Least Volume Managment

4. Linux and window both are same operating system . Is this True ?

a.
b.
c.
d.

Ans

True

False

Not Sure

Both are operating system

: b- False
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5. Images made up of geometrical shapes are ?

a.
b.
C.
d.

Bitmap Images
Vector Images
Both Type
JPEG images

Ans b — vectorimages

6. If you are designing a logo in CorelDRAW, you would like to keep the quality of your

the

logo to be usable across different media 8o, how should we do it properly while exporting

logo?

a. Export logo as high quality JPIEG to use over all applications
b. Export the logo as a vector format (SVG, EPS etc..This ensures that it retains its
scalability and clarity.

¢. Export the logo and PNG with a transparent background, high resolution
d. Export Logo as JPEG with high resolution

Ansb. - Export-the-logo-as-a-vector format- (SVG;, EPS ete.. This ensures-that it retains-its
scalability and-elarity
7. Which of the following is code used ffor inserting external style sheet in PHP
a. <link rel="stylesheet" type="text/css" href="styles.css">
b. <style src="css/styles.css"></style>
C. <link rel="stylesheet" href="/css/styles.css">
d.  None of Above

Ams-a. <linkrel="stylesheet" type="text/css" href="styles:css">

8. What is output of Following code
$number = 15;

if
{

}

($number > 20)

echo "Greater than 20";

Else

{
}

mn Fe

echo "20 or less";

Greater than 20
20 or less
15

No result

Ans : b-20 or less




=

9. Let's say you have 2 tables;) one for Orders and another Products in an e-commerce
database Each order may include multiple products, and every product can be a part of
more than one order. How do you put the primary and foreign keys in place?

a) Using OrderlD as the primary key in Orders and ProductID as the primary key in
Products then creating an orderltems table of connecting two main tables through it
using constitutional foreign keys(Orderld,product ID).

b) Make ProductName as the primary key in Products Table, and OrderNumberas the
primaryKeyin OrdersTable.

c) Use OrderID as a primary key for both Orders and Products tables .

d)  Have the ProductID as the primary key in this Products table and OrderID as a
foregin key in an associated Orders tablerias

Ans : b -Using OrderlD as the primary-key-in Orders and ProduetiD-as-the primarykey-in
Productsthen-creating an arderltems table-of connecting two main tables-through-it-using
canstitutional foreign keys(Orderid;preductD).

10.Which of the following is an example of DBMS

a.  Mysql

b.  Google

C. PHP

d.  Javascript
Ans-: a- Mysql

11.which command is used in PL/sql to show data of those students who have less than 50%
marks in table CS.

a. SELECT * FROM CS WHERE Marks < 50;
b. Select CS where marks>50%;

c. SELECT * FROM CS WHERIE Marks >50;
d. Select all from CS where Marks<50;

Ans T aSEEEETF* FROM €S WHERE Marks < 50

12.You are about to make a purchase on an online shopping site and notice that the URL
shows "http://" instead of "https://". As you evaluate the risks and decide whether to
proceed, which of the following considerations should be prioritized?

a) "The absence of 'hitps://' indicates that the website does not use encryption to protect
your payment details, increasing the risk of data interception and potential fraud."

b) "The presence of 'http://" implies that the website may offer better user experience due
to faster page loading times."

c¢) "The 'hitp://' in the URL suggests that the website has limited options for payment
methods, affecting your choice of payment."

d) "The 'http://" protocol indicates that the website does not provide instant customer
support for transaction issues."




Ams: a- "The-absenee of 'hitps:// indicates-that the website does not ueeﬂCfYPtT’" ko
protect yourpayment details, increasing the-risk of data-intereeption and-potentia

framd:"
Answer the following questions. (243=5)
13.What is use of shell commands in Linux . Write any two points . (2)

Answer : The use of shell commands are: as follows :

% Shell commands are used to create:, delete, and manage files and directories, such as Is
to list files and rm to remove them. '

. Shell commands help monitor sys tem performance and manage processes, like top to
view running processes and ps to check process status'l @

14.What is the difference between Linux and Window NT. Mention any three differences to

support the same . 3)
Answer : [
Sr No Linux Window
1. Linux is open source operating | Window is not an open source operating L 4|
system system
\ 2. Linux is free of cost Window is not free operating system and
is costly
\ 3. linux is more efficient as Window OS is less efficient. |
compare to window OS

i

Answer the following question (Maximum 100 words) (3+3=6)

13. Explam following commands in one line with syntax (any three) (1*3=3)
1 Cd:

CD command in Linux is used to change the current workmg dlrectory
Syntax: CD[directory

ii.  Echo:

The echo command in Linux is used to display a line of text or a variable value to
the terminal.

Syntax : echo [text or variable)) \@

iii.  Printf:




Syntax : printf(format, arguments); e -

The printf command in PHP is used to format ?ctnu{put a string.
y )

iv. Rmdir: .
The rmdir command in Linux is used to remove an empty directory. £y

Syntax : rmdir{directory_name] / .

V. B4 ‘ (r_ l(ﬂ% 1O ra)
\

The Is command in Linux is used to list the contents of a directory. \

Syntax : Is [options] [directory ] \
vi. Who:

The who command in Linux displays a list of users currently logged into the

system.
Syantx : Who[options]

16. Describe the concept of input and output redirection with appropriate examples. (3)

Answer : Input and [o-'ﬁrt redirection in Linux allow users to control where data is read
np

from or written to)) redirection (<) takes input from a file instead of the keyboard.
For example, command < inputfile.txt feeds the contents of inputfile.txt to command. —@

Output redirection (>) sends the output of a command to a file, overwriting it if it exists.
For instance, command > outputfile.txt writes the command's output to outputfile.txt.
Using >> appends to the file instead of overwriting.

For example, command >> outputfile.txt adds the command's output to the end of

outputﬁle.txtl

Answer the following questions (word Limit 150-200 words) (4*3=12)

17. Explain any two tools used in corel draw . (2+2=4)
Answer : » Pen Tool: The Pen Tool is essential for drawing precise paths and shapes. It allows
users to create straight lines, curves, and coiglex shapes by placing anchor points and adjusting
their handles to control the curvature.| This tookis i valuable for creating custom illustrations,

logos, and detailed vector artwork.

[0 Shape Tool: The Shape Tool is used to modify and refine shapes that have been created with
other tools. It enables users to edit individual nodes and control the curvature of the shapq’s) is '3)
tool is ideal for adjusting the details of vector ebjects, such as rounding corners, changing the

shape's path, or fine-tuning the design. «— L(

18. Define what a variable is in PHP and discuss the different variable scopes within the

language (143=4)
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Answer : Variable : In PHP, a variable is a symbolic name associated with a ‘{alue, which
can be modified during script execution. Variables in PHP start with a dollar sign (%), "
followed by the variable name (e.g., $variable), They can hold different types of data, s

as integers, strings, arrays, and objects __@

Scope of Variable : There are two scopes :

1. Local Scope : Variables declared inside a function or a block are local to that
function or block. They are not accessible outside of it. For example:
function example() {

$localVar = "I'm local";

}

// $localVar is not accessible here

ii.  Global Scope: Variables declared outside of functions are in the global scope and

can be accessed throughout the script. To use a global variable inside a function, the
global keyword must be used: '
$globalVar = "I'm global"; |

function example() { |
global $globalVar; — Q
echo $globalVar; -

}

19. You are tasked with designing a school logo using CorelDRAW. The logo should
include a combination of text and a desired vector shape. Explain the basic steps you
would follow to create this logo, including how to lock objects in this logo. (2+2=4)

Answer : To design a school logo using CoreDRAW, follow these basic steps:

1. Start a New Document: Open CoreDRAW and create a new document by selecting
"File" > "New." Set the desired dimensions and resolution for your logo.

2. Draw Vector Shapes: Use the Pen Tool or Shape Tool to create the vector shapes for the
logo. For example, draw a shield, circle, or any shape that fits yo sign. Customize the
shape’s color, outline, and style using; the properties bar. 1)

3. Add Text: Select the Text Tool and click on the canvas to type the school’s name or
motto. Choose an appropriate font, size, and style that complements the vector shapes.

4. Arrange and Align: Use the Pick Tool to move, resize, and align text and shapes. Utilize
alignment and distribution options under the "Arrange" menu to ensure proper positioning.

5. Group Elements: To keep the design organized, select all elements (shapes and text N
group them by pressing Ctrl+G. This ensures they move together as a single, unit. 4@7

Steps to Lock Objects :

AT YR

T

T YR P S T B TN A T T

6. Lock Objects: To prevent accidental changes, lock objects by selecting them, right-

clicking, and choosing "Lock Object."/This will keep them in place while you work on
other parts of the design. —

7. Save Your Work: Save your logo by choosing "File" > "Save As" and select the desired
file format, such as CDR or PDF. _ @
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Compare bitmap and vector images in terms of resolution and scalability. How does each
type affect image quality when resized? Bers i A \Tj

Answer : Bitmap and vector images differ significantly in terms of resolution and
scalability.

Bitmap images (also known as raster- images) are made up of pixels, with each pixel ( b
representing a specific color. As a result, the resolution of a bitmap image is ﬁxed_.]When
you enlarge a bitmap image beyond its original resolution, the image becomes pixelated,

leading to a loss in quality. This is because the fixed number of pixels gets stretched,
causing visible distortions and blurriness. s

On the other hand, vector images are: composed of mathematical formulas that define
shapes, lines, and colors. Since vectors are #0t dependent on resolution, they can be scaled
infinitely without any loss of qﬁalitﬂWhen :sized, a vector image retains its sharpness
and clarity, making it ideal for logos, icons, and other designs that need to be resized

frequently. _ g Q@m%m m\\%_n\ B Conbe Aore

A
Ralat bt\km\’“ (\%Q'K”m '
Answer the following question (Word limit 300 words ) (5*2=10)

20. What is a Data Dictionary in the context of database management? Describe the
different types of Data Dictionaries and explain how each type serves a unique purpose in
managing and organizing data. i , (2+3=5)

Answer : In database management, a Data Dictionary is a centralized repository that stores

metadata about the database's structure and organization. It provides information about the

database schema, in: ing tables, coluimhs, data types, relationships, constraints, and access
permjssionslThc Data-Dictionary helps in managing, maintaining, and understanding the

database efficiently by serving as a reference for database administrators, developers, and users. f L )

Types of Data Dictionaries

1. Active Data Dictionary: ‘
o Definition: Integrated into the database management system (DBMS%:“P"I\ updated
automatically as changes are made to the database schema. | . 7 |
o Purpose: Ensures real-time synchronization between the database schema and its
metadata. It provides immediate access to current database definitions and 3
structures. This type is essential for dynamic environments where the schema {7
frequently changes.

o Example: Oracle's data dictionary views like USER_TABLES and . 4 3
ALL COLUMNS that automatically reflect changes to the schema. b




2. Passive Data Dictionary:

o Definition: Maintained separately from the DBMS, often as documentatio
d

of files that must be updated manually. o '

o Purpose: Used for documentation and reference purposes. It helps in erstanding
the database schema but requires manual updates to reflect changes in the actual '
database. This type is often used in environments where schema changes are

infrequent.
o Example: A spreadsheet or document listing database tables, columns, and 5\)

n or a set

relationships that is updated manually by database administrators.

OR
You have given an table name <STUDENT> in MYSQL with following data : |
PEDE S
Student | Name Marks Term 1 Marks Term 2 - g
1D S
001 Naman 50 86 |
002 Neha 85 _ 95 : |
003 _ Ojas = |75 : 160 3
004 Sumit 88 |40

write the code utilizing appropriate functions in MY/SQL to accomplish the following tasks:
(a) Display the name of student who scored greater than 80 marks in Term 1.
(b) Display StudentID of student who scored less than than 70 marks in Term 2.

(c) Display Maximum marks in term 1.

Answer : (a) we use the SELECT statement to display the n of students who meet the
condition Marks_Term_1 > 80 @
SELECT Name
FROM STUDENT

WHERE Marks Term_1 > 80;

This will display two names i.c Neha and sumit

A

~(b) Here we will use select statemen tch StudentID of those student who meet the ‘7
condition IBSIR v

SELECT StudentID




FROM STUDENT /(‘—\
WHERE Marks_Term 2 < 70; - /
This will display two names i.c Ojas and sumit

(¢) To display the maximum marks in Term 1, you can use the MAX() function

in MySQL: b
SELECT MAX(Marks_Term ‘1) AS Max_Marks_Term_] ’.6 J
FROM STUDENT;

21.Amazon and Flipkart operate in both B2C (Business-to-Consumer) and B2B (Business-to-
Business) e-commerce models. Explain how these platforms utilize both types of e-
commerce. (5)

Answer : Amazon and Flipkart are promineint e-commerce platforms that effectively operate in
both B2C (Business-to-Consum d B2B (Business-to-Business) models, addressing a wide
range of market needs. \ . R o T

In the B2C model, both platforms focus on selling directly to individual consumers. They offer a
diverse array of products, such as electronics, clothing, home goods, and groceries, through their
online marketplaces. To enhance the consurner experience, Amazon and Flipkart invest in
creating usg%‘icndly i es, personalized recommendations, and efficient search
functionalities.| They alsd-efphasize providing detailed product descriptions, customer reviews,
and ratings to aid in decision-making. Their logistics networks are designed to ensure prompt
delivery, with options for same-day or next-day service, free shipping on certain orders, and easy
returns. Dedicated customer support teams handle ipquiries and after-sales services, aiming to

provide a seamless shopping experience. —— 8

In the B2B model, Amazon and Flipkart facilitate transactions between businesses, allowing
them to buy and sell products in bulk or source necessary materials. They offer wholesale
services where businesses can purchase items in large tities at discounted rates, which is
particularly advantageous for retailers and resellers platforms also connect suppliers and
manufacturers with businesses seeking products, providing tools for managing bulk orders,
tracking shipments, and accessing a broad range of business-oriented goods. Additionally, they
offer business-specific features such as tax exemptions, integration with procurement systems,
and advanced reporting tools-te help businesses manage their purchases and inventory

effectively. e
=1

By integrating both B2 1A B2B models, Amazon and Flipkart are able to expand their market
reach and diversify their revenue streams, serving the needs of both individual consumers and
businesses.

B T S——
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OR

¥ . . . . . - ¢ . G . : (j'\/‘;
What are the primary advantages of social media in education? Provide ; 0f b

students can use social media platforms to enhance their learning.

Answer : Social media has become an integral part of education, offering numeroeus atdvantages
that help students enhance their learning experience. The primary benefits include increased
collaboration, accessibility to diverse learning resources, real-time communication, and the
ability to engage with global communitics. | ’ \ |

—

1. Collaboration and Group Learning: Social media platforms like Facebook, WhatsApp,
and Slack allow students to create study groups, share resources, and collaborate on
projects in real-time. For example, students working on a group assignment can use these

platforms to discuss ideas, delegate tasks, and pr;w@stant feedback, even if they are

not physically together.

2. Access to a Wealth of Information: Platforms like-¥ouTube, Instagram, and LinkedIn
host a plethora of educational content, ranging from tutorials and lectures to infographics
and case studies. For instance, students can watch YouTube videos to understand complex
topics such as calculus, coding, or historical events. LinkedIn Learning provides courses
on various professional skills, enabling students to supplement their academic learning.

3. Real-Time Communication and Feedback: Social media allows for instant '
communication between students and teachers. Twitter, for example, can be used by
educators to share important announcements, links to academic articles, or updates on
assignments. Students can also estions and receive real-time answers, promoting
continuous learning. — I, :

4. Engagement with Global Communiities: Social media breaks down geographical
barriers, enabling students to connect with peers, professionals, and subject matter experts
worldwide. Platforms like Reddit and Quora have educational forums where students can
engage in discussions, ask questions, and gain insights from global contributors. This
exposure to different perspectives enhances critical thinking and broadens their
understanding of various subjects. '

Answer the following questions with proper programming code (13=1)

22. You are developing a student grading system for a class using PHP. The grades should
be given based on students %age score and  display a message .Using if-else statement
in PHP , explain how you would implement the following grading criteria: (5)

Assign a grade of "A" for scores 90% and above.

Assign a grade of "B" for scores between 80% and 60%.

Assign a grade of "C" for scores between 50% to 40%

Assign Grade D for score below 40%

Di;glay a message for the student, such as "Excellent", "Good", "Fair", based on their
grade.

RN
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Answer : <?php

// Function to determine the grade based on percentage score

function determineGrade($percentage) {

if ($percentage >= 90) {
return "A+"; ———C@

} elseif ($percentage >= 80) {

returm "A"; s @

} elseif ($percentage >= 70) {

return "B+";

} elseif ($percentage >= 60) { ey =
fﬂ@ Gurstion cor

y elseif ($percentage >= 50) { e Q&\'\f e U@':*Ho{&

return "C+"; "y @ . LP&&'S Pum_'\,‘e,ﬂ |

} elseif ($percentage >= 40) {
return "C"; _

J else {

return "F"; 7
}

// Example student score
$studentScore = 75; // Replace with the actual score

$percentage = $studentScore; // Assume $studentScore is the percentage

// Get the grade
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$grade = determincGrade($percentage);

vt
G

i // Display the results
§
i
‘ ccho "Student's percentage: " . $percentage . "%<br>";
4
4
E echo "Student's grade: " . $grade;
: >
OR
] PL/SQL. is an extension of SQL that adds procedural capabilitics. Analyze the five  key
] differences between SQL and PL/SQL in terms of their structure, execution, error
i handling procedures and facilities. (6)
j Answer: )
I
é
] : | Dedarative language wsed fior
i ! | Structure i - - 1 ) .
| VR SiniiiniaiBIN W | querying and manipulating data. | variables, loops, and conditions.
! 2 Execution | Executes one staternent st a | Emsostes multiple statements in a block.
T i time (independent aperations).  allowing control flow logic.
E | 3 Error Handlmg ‘ lelted ervor handling mainlyat = Advanced eror handlu_ng using EXCEPTION
1 the query level (e.g. constraint blocks for handling runtime erors. -
] ' violations).
: - — — : o .
1 | 4 Procedural Lacks procedural constructs (no. Supports procedural constructs hke loops
ﬁ Capabilities ‘loaps. if-else, etc). ' ' ( FOR . kaL[Q. conditionals { IF-ELSE ), and | m
S "' functions. |
| 5 Data Handling Direct interaction with datzhases  Can manage data using SQL queries, plus I
for data retrieval and lagic to manipulate and contral flow using |
1 manipulation. varisbies and procedures. [ 5
I | . |
iz 5 il
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23.  You arc assigned the responsibility of designing and managing a database for a school’s
student records using MySQI.. Your task involves creating a table named studentDB to store
detailed student information such as Name. Class, Roll No, Student 1, and Address. How would
vou write and execute the MySQIL commands to create this table?

Answer:  CREATE TABLE studentDB(  — ( "\) Cary
\ 7‘\‘)'\\;(\01\"\“' @m%

Name VARCHAR(100) NOT NULL, _ .
— (3”“) Ai8crbe, Lse

Class VARCHAR(20) NOT NULL,
RollNo INT NOT NULL UNIQUE, (rf) R
StudentD VARCHAR(20) PRIMARY KEY, _ . [

Address TEXT @

OR

Describe how DDL (Data Definition Language) commands are utilized to define and modify the
structure of database objects. Af% ionally, explain any two DDL commands with suitable

examples. C% Sy ,\_\) -

Answer : Data Definition Language (DDL) commands play a crucial role in SQL for deﬁniniﬁ

and altering the structure of database objects, such as tables, indexes, and schcma;{\ Thes

commands enable users to create, modify, and_delete ponents of a database, facilitating
the organization and storage of data effectively)\ By mL commands, users can establish
the rules and layout of their databases, ensuring that data is structured appropriately for their

needs.
I

Two DDI commands are as follows :

1 CREATE: This command is used to create new database objects. For example, to create a
new table, you specify the columns, their data types, and any rules (constraints).

Example : CREATE TABLE Students (
StudentID INT PRIMARY KEY,
Name VARCHAR(100),

—

Age INT,

OXY £ al \(\ E‘Lﬁ\ L
\_k‘_f\ i -'\“’f\; &c:[\ m‘l\\(j PP .
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Marks DECIMAL(S,2)
):

3. ALTER: This command is used to chiange the structure of an existing database object. You
can use it to add new columns, change data types, or remove columns from a table.

ALTER TABLE Students

ADD Email VARCHAR(100);

24 (i) Create a program in PL/SQL to display greater between 3 given Numbers (3)
DECLARE
numl NUMBER := 15; -- Replace with your first number

num2 NUMBER := 30; -- Replace with your second number

greatest NUMBER; N — @

BEGIN
-- Compare the numbers and determine the greatest

IF num1 >=num2 AND THEN

greatest = numl; @

ELSE
greatest := num2;

END IF;

-- Display the greatest number
DBMS_OUTPUT.PUT_LINE('The greatest number is: ' atest);
END;

/

RS
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(i) Create a program in PHP to determine whether the given number is even or odd (2) {

<?php

$inputNumber = 7; / You can change this value to test with other numbers

if ($inputNumber % 2 == 0) __@
{

echo "$inputNumber is Even.";
} else {

echo "$inputNumber is Odd.";
3

™

Blueprint for Marks Distribution :

SrNo | Type of Question |Marks No of Total Marks
Awarded Question
1. MCQ 1 12 1¥12=12
2 Very Short 5 (2+3) 2 5
Answer Type
Questions




